
N° 01/2011 (43)   Mensuel   Janvier   ISSN 1733-2745  

Partenaire du numéro

Mixez les pixels  
et formes vectorielles

Illusion de la 3D  
créez un photomontage  
sous Photoshop et Illustrator

Photos de nuit 
jouez avec les obmbres  

et lumières

Choisissez bien L’ÉCLAIRAGE  
pour les photos de beauté

http://www.fotolia.fr


http://www.printmania.com


Le magazine .psd est publié  
par Software Press Sp. z o.o. SK

Président de Software Press Sp. z o.o. SK
Paweł Marciniak
Directrice de la publication
Ewa Łozowicka

ISSN : 1733-2745

(c) 2011 Software Press Sp. z o.o. SK,
tous droits réservés

Rédactrice en chef
Justyna Książek
justyna.ksiazek@psdmag.org

DTP
Graphics & Design Eurodesign
www.euro-design.info

Photo de couverture 
Sébastien Vandenwouwer

Bétatests
Jonathan Marois, Patrick Haond,  
Benoît Recarte, Charline Goutx,  
Hélène Hertgen, Aurélien Lautour
 

Les personnes intéressées par la coopération sont priées 
de nous contacter : fr@psdmag.org

Publicité
publicite@software.com.pl 

Software Press Sp. z o.o. SK
ul. Bokserska 1, 02-682 Varsovie, Pologne
tél. +33 170 610 717, fax +48 22 244-24-59
http://www.psdmag.org/fr

Tous les logos et marques déposées sont la propriété de leurs 
propriétaires respectifs.

   

3 .psd 01/2011 | www.psdmag.org/fr

Chers 
lecteurs,
Dans ce premier numéro de l’année 2011, nous 
avons choisi le visuel de couverture qui fait penser 
à la période de carnaval. L’auteur, Sébastien 
Vandenwouwer, vous montrera comment réaliser un 
visuel dynamique mélangeant les formes vectorielles 
et pixels à l’aide de Photoshop et Illustrator.

Nous vous conseillons aussi de suivre le tutoriel 
d’Arnaud Gomet Eat me grâce auquel vous 
apprendrez à créer une image qui donne l’illusion 
de la 3D. Vous pourrez donc maîtriser les outils de 
Photoshop et Illustrator pour obtenir un effet abstrait.

Pour ceux qui s’intéressent à la photographie nous 
avons préparé deux articles. Premier texte de Richard 
Vantielcke vous expliquera comment obtenir un effet 
intéressante des photos de nuits. Vous verrez donc 
une joue des ombres et de lumières, vous connaîtrez 
une particularité de ces types de photos ainsi que 
quelques conseils pour les retoucher.

Deuxième article sur la photographie traite sur 
l’éclairage en studio. L’auteur de Un éclairage beauté 
en studio, Gérard Chesneau, vous expliquera en quoi 
consiste un éclairage classique et il vous proposera un 
type d’éclairage approprié aux photos de beauté.

Bonne lecture et Bonne Année 2011 à tous,
équipe .psd Photoshop

http://www.euro-design.info
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Pink Me a été réalisée à l’aide de Photoshop  

et d’Illustrator, mixer le vectoriel avec le pixel  

donne toujours de bons effets. Comme pour mon 

tutoriel précédent, il faut maîtriser les bases  

de Photoshop, à savoir : la gestion de calques,  

de groupes et l’usage des masques de fusion.

Pink Me 

Sébastien Vandenwouwer
Je suis infographiste et graphiste 
professionnel. Pour moi le graphisme est 
synonyme de passion! J’ai débuté avec 
photoshop 7.0, mes débuts furent certes 
chaotiques car je n’utilisais que la baguette 

magique… mais depuis j’ai un peu évolué! J’ai suivi une formation 
d’infographie à 19 ans! Voilà déjà 2 ans que je travaille dans une agence 
bruxelloise spécialisée dans le domaine pharmaceutique et cosmétique. 
Mon job consiste en la création de plv (publicité sur lieu de vente), du 
display à l’argumentaire de vente en passant par les logotypes et le 
packaging. Cependant l’illustration que vous allez découvrir reflète une 
autre facette de mon travail. Pour en savoir un peu plus sur mon travail 
perso, visitez mon portfolio sur : www.vs-creations.be 

Photoshop CS5 Illustrator CS5 | intermédiaire | 90 min
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1: DÉFINIR VOTRE FORMAT D’IMAGE FINAL
Ouvrez Photoshop et créez un nouveau document : Fichier>Nouveau, 
choisissez la taille de votre document final (par exemple 40x40 cm 

en 300 dpi). Il est important que votre mode colorimétrique soit le 
RVB. Le CMJN est un mode qui ne permet pas de jouir de toutes les 
options de Photoshop !

2: NOTRE FOND
Comme son nom l’indique pink me baignera dans une atmosphère 
rose, j’ai utilisé un rose bonbon (réglage RVB suivant : R 226, V 0, B 
122). Donnez du mouvement et du dynamisme à votre fond en créant 
des formes rectangulaires parallèles. J’ai importé mes formes depuis 
Illustrator vers Photoshop. Quand vous faites cette manipulation 
vous devez cocher la case Pixel afin de pouvoir appliquer un masque 
sur votre calque. Vous pouvez également créer vos rectangles direc-
tement dans Photoshop. Appliquez ensuite un masque sur votre 
calque rectangles, utilisez l’outil Dégradé radial [G] afin d’avoir un 
beau fondu entre vos rectangles et votre fond rose.
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3: DÉTOURAGE CHEVEUX…EASY AVEC CS5
Le sujet que j’ai choisi possède une chevelure assez complexe, 
se qui rend difficile le détourage du modèle. Mais Photoshop 
CS5 possède une nouvelle option qui facilite considérablement 
cette tâche. Prenez l’un de vos outils de sélection classique et 
sélectionnez la tête du personnage. J’ai utilisé l’outil Baguette 
magique [W], cliquez ensuite sur le bouton Améliorer les contours 
Menu>Sélection>Améliorer les contours. Une fenêtre apparaît, 
appuyez sur [E] et peignez sur la zone des cheveux tout en gar-
dant la fenêtre de sélection active. Afin d’avoir une sélection par-
faite, passez deux, trois fois sur les zones plus détaillées. Cliquez 
sur OK et l’affaire est dans le sac.
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4: TÊTE À FACETTE
Téléchargez ou photographiez une boule à facette, détourez celle-
ci et importez-la dans votre espace de travail. Mettez votre calque 
facette en mode Incrustation par dessus le calque lady et la magie 
de Photoshop agit, votre modèle a une tête à facette. Dupliquez 
le calque si vous souhaitez avoir un effet plus marqué. Dupliquez 
à nouveau votre calque facette (toujours en mode Incrustation) 
et mettez celui-ci en dessous de votre sujet principal, votre boule 
devient alors rose !
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5: FORME VECTORIELLE
Importez d’Illustrator des formes vectorielles que 
vous avez préalablement créées. Une fenêtre appa-
raît lorsque vous copiez une forme vectorielle dans 
Photoshop, sélectionnez l’onglet Pixels. L’avantage 
de cette technique est de pouvoir appliquer à vos 
anciennes formes vectorielles des masques de fusion ! 
 Voulant avoir un côté très disco, la majeure partie de 
mon illustration possède des cercles avec lesquels j’ai 
joué en opacité.

6: PHOTOMONTAGE
Il est toujours intéressant d’ajouter du détail dans l’illustration, j’ai 
donc créé un baffle à l’aide d’un citron et d’un gramophone. Ouvrez 
vos deux images dans Photoshop, détourez-les, utilisez ensuite l’ou-
til Déformation [Cmd]/[Ctrl]+[T] afin d’avoir un montage le plus réa-
liste possible.

5
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7: splash
Ouvrez la photo splash, détourez-la à l’aide de la Baguette magique 
[W] ou de la Plume [P]. Afin de changer la couleur de votre splash, 
faites [Cmd]/[Ctrl]+[U] et jouez avec la barre des teintes afin d’obtenir 
la couleur souhaitée, ma barre des teintes est à +125. Ensuite impor-
tez votre splash coloré dans votre espace de travail et appliquez un 
masque à votre calque, ensuite effacez les zones inintéressantes.

8: TYPOGRAPHIE
La typographie est un élé-
ment graphique à part 
entière, c’est pourquoi il est 
toujours intéressant d’en 
insérer dans vos créations. 
Choisissez donc une typo-
graphie que vous trouvez 
graphiquement intéressante 
et incrustez-la dans votre 
photomontage.

7
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9: PINK EYES
Créez une bande de couleur rose traversant toute votre image et 
appliquez-le mode Couleur à votre calque. Ensuite à l’aide de la 
Plume, redessinez les contours de ses lunettes afin d’accentuer la 
présence de celle-ci.

10: NETTETÉ
Accentuez également la netteté de votre illustration en utilisant le 
filtre Passe-haut. Pour ce faire nous allons aplatir tous les calques 
(il est préférable de dupliquer votre image : Image>Dupliquer). Une 
fois l’image aplatie, dupliquez le calque aplatit et positionnez le nou-
veau calque au-dessus du premier calque en lui appliquant un filtre 
Passe-haut : Filtre>Divers>Passe-haut. Cet outil permet de mettre 
en évidence les petits détails, on obtient une image sur une base de 
gris moyen où ressortent les détails en ombres et lumières. Passez 
ce calque en mode Lumière linéaire en opacité 47%. Réglez votre 
opacité en fonction de l’effet souhaité. Voilà votre illustration est finie, 
merci de votre lecture.

9
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Photoshop CS4 Illustrator CS4 | intermédiaire | 90 min

Eat me – illusion de 3D sous Photoshop et Illustrator



1: PREPARATION DU DOCUMENT
Créer un nouveau document 60x40 cm en 300 dpi et 
en mode RVB. Remplissez votre calque de fond avec 
une couleur grise.

2: FOND DU DOCUMENT
Ajoutez la texture de papier à notre fond, passez son 
mode de fusion sur Incrustation et baissez son opa-
cité à 75%. On va ajouter un peu de lumière, choisis-
sez un Dégradé radial, allant du blanc vers le trans-
parent. Placez-le au centre de votre document, puis 
baissez son opacité à 75%. Ajoutez un autre calque, 
et avec un pinceau doux à 15-20% d’opacité, assom-
brissez les angles.

1

Dans ce tutoriel, j’ai essayé de réaliser une illustration complètement 

abstraite avec une impression de 3D. Tout les éléments ont été réalisé 

sous Photoshop et Illustrator. Les images sources proviennent de 

DeviantArt et de Photoxpress.

Eat me –

Arnaud Gomet
Il est un jeune graphiste/illustrateur. Diplômé 
d’une école d’art, il exerce son activité en 
tant que freelance sur la ville de Rennes. 
N’hésitez pas à le contacter pour en savoir 
plus: http://arnographik.daportfolio.com/

illusion de 3D sous 
Photoshop et Illustrator

2
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Eat me – illusion de 3D sous Photoshop et Illustrator

3: NUAGES
À l’aide des photos de références que vous trouve-
rez avec les fichiers sources, nous allons créer une 
bande nuageuse. Choisissez une des photos, puis 
importez-la sur votre plan de travail. Désaturez-la 
(Image>Réglages>Teinte/Saturation) ou [Ctrl]+[U]. 
Ajoutez un masque de fusion et effacez les bords pour 
mieux les intégrer à notre fond. Répétez cette opéra-
tion plusieurs fois, essayez d’obtenir le même résultat 
que sur la capture.

5: VOLUME
Dans la barre d’outil, prenez l’outil Densité +, choi-
sissez une forme de pinceau doux et une taille assez 
grande, réglez la gamme sur Ton clair et un Taux d’ex-
position à 10%. Vous pouvez maintenant peindre les 
ombres sur notre cercle.

4: BOULES
Dans cette étape, nous allons voir comment dessi-
ner une boule. Choisissez l’outil Ellipse dans la barre 
d’outil, prenez une couleur blanche puis cliquez au 
centre de votre document en maintenant les touches 
[Alt]+[Maj], de cette manière vous aurez un cercle par-
fait. Dans le panneau des calques faites un clic droit 
sur la forme que vous venez de créer et cliquez sur 
Pixelliser le calque. 

6: BOUCHE
Dupliquez la boule et réduisez sa taille, placez-la en 
bas à droite de l’autre boule. Maintenant, ouvrez la 
photo Photoxpress_46928763 et avec l’outil Lasso 
sélectionnez la bouche. Coupez et collez votre sélec-
tion dans votre document, désaturez-la [Ctrl]+[U]. 
Redimensionnez-la et appliquez-lui un masque de 
fusion ainsi qu’à la boule. Peignez sur le masque de 
fusion avec un pinceau à bord doux et un faible opa-
cité pour effacez les contours de la bouche. Effacez 
également la partie de la boule qui se trouve derrière 
la bouche.

3

5

4

6
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Eat me – illusion de 3D sous Photoshop et Illustrator

7: OEIL
Dupliquez encore une fois la boule et placez-la 
comme sur la capture. Ouvrez maintenant la photo 
œil. Comme à l’étape précédente, faites une sélec-
tion tout autour de l’œil avec le Lasso. Coupez, puis 
collez votre sélection dans le document, désaturez-la 
[Ctrl]+[U] et appliquez-lui un masque de fusion. Inté-
grez l’image à la boule en effaçant les parties inutiles.

9: BOULES 2
Continuez à placer 
quelques boules ici et là, 
modifiez leur taille, utili-
sez les outils de trans-
formation pour les défor-
mer. Pensez à flouter 
les boules qui se situent 
au premier plan, cela 
va permettre de donner 
plus de profondeur à 
notre image.

8: OMBRES
Pour donner plus de relief, nous allons peindre l’ombre 
de la boule. Pour cela, créez un nouveau calque et 
placez-le en-dessous de la boule. Passez son mode 
de fusion sur Produit, puis avec un pinceau rond et 
noir à bord doux, d’une opacité de 10%, peignez 
l’ombre de boule.

10: LUNES
Ouvrez la photo de la 
lune_01 et importez-la 
dans le document. Redi-
mensionnez-la et pla-
cez-la en haut à gauche, 
passez son mode de 
fusion sur Éclaircir. 
Ouvrez et importez la 
seconde photo lune_02 
et placez-la à droite 
de l’autre lune, passez 
son mode de fusion sur 
Superposition. 

9 10

7

11

8
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11: PYRAMIDES
Ouvrez Illustrator, et avec l’outil Plume, tracez des 
triangles de manières à créer des pyramides. Rem-
plissez avec du noir et du gris puis importez-les dans 
Photoshop. Dupliquer la pyramide et avec les outils 
de déformation, changez les perspectives pour créer 
d’autres pyramides.

12: CERCLES
Revenez dans Illustrator, prenez l’outil Ellipse et tout 
en maintenant la touche [Alt], créez une série de 
cercles en alternant les couleurs. Importez-les dans 
Photoshop et placez-les à l’arrière-plan, derrière les 
pyramides. J’ai également ajouté un calque entre les 
pyramides et les cercles pour pouvoir peindre des 
ombres.

17 .psd 01/2011 | www.psdmag.org/fr
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Eat me – illusion de 3D sous Photoshop et Illustrator
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13: BARRES
Avec l’outil Rectangle, tracez un rectangle long et fin, 
ensuite choisissez Pixelliser le calque. Récupérez la 
sélection et remplissez-la avec un Dégradé linéaire. 
Dans l’éditeur de dégradés, rentrez ces réglages : à 
0% en position, choisissez une couleur #4f4f50, à 30% 
#080808, à 62% #646464, à 100% #ededed. J’ai éga-
lement peint l’ombre de la barre qui est projetée sur la 
boule. Dupliquez-la une fois et placez en une autre à 
un autre endroit.

14: DÉTAILS
Avec des formes de pinceaux personnalisées que 
vous trouverez avec les fichiers sources, j’ai ajouté 
un peu de vie dans notre illustration en peignant 
quelques oiseaux. Pour finir et pour ajouter un peu 
de dynamisme à notre image, j’ai tracé quelques 
triangles avec la Plume. J’ai également encore rajouté 
quelques boules.

13
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Depuis peu, je m’inspire du mouvement steampunk dans mes 

créations pour leurs donner une touche apocalypto – futuriste.  

J’ai voulu, dans cette création, montrer un monde désert peuplé 

de poissons de la mort … Un manière d’imaginer le futur. 2012 

approche, voilà ce qui nous attends !

STEAMPUNK
Romain MATHIEU  
aka mixerbink
Graphiste de 24 ans 
originaire de Luxeuil-Les-
Bains (70) au nord est de 
la France. J’ai reçu une 
formation graphique à 
19 ans. J’ai toujours été 
créatif et j’ai mis du temps à 
savoir dans quelle branche 

je m’orienterais. J’ai fini mes études depuis deux ans 
et j’ai un job de graphiste à la mairie de Luxeuil-Les-
Bains. C’est mon second tutoriel pour ce magazine et 
je trouve ça très intéressant. Je n’avais jamais vraiment 
eu l’occasion de revenir sur mes créations.
Site : http://www.mixerbink.deviantart.com

Fish

Photoshop CS3 | avancé | 90 min
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1: DIMENSIONS DU DOCUMENT
Pour cette création, j’ai utilisé de nombreuses images. Presque toutes les images 
doivent être détourées. Pour ce tutoriel j’ai choisi de travailler en Niveaux de gris 
avec un format de 1600 x 900 px et une Résolution de 150 dpia.

1

2: LE POISSON PRINCIPAL
Le détourage est à la base de toutes les photomon-
tages. Pour un détourage rapide et précis utilisez la 
Plume. Pour plus de précision, zoomez à fond. Gardez 
un doigt sur [espace] et un doigt sur [clic] pour se 
déplacer rapidement. Nommez le calque poisson.

2



STEAMPUNK FISH

21

3: NOIR ET BLANC PROFOND
J’ai voulu donner un aspect ténébreux au poisson. J’ai donc décidé 
de changer le mode colorimétrique de Niveaux de gris. Pour cela,  
il suffit de faire Images>Mode>Niveaux de gris. Les rayures du poisson

 ne me paraissaient pas assez foncées. J’ai donc utilisé l’outil Densité 
+ sur les rayures et les nageoires du poisson, avec un pinceau épais 
de contour doux et une exposition de 20%.

4: L’ŒIL
Pour l’aspect steampunk. J’ai commencé par changer l’œil du poisson. 
Pour cela, il faut importer dans votre document le fichier objectif.jpg. Un 
nouveau calque est créé, nommez-le objectif. Ce calque doit être en 
dessous du calque poisson. Ensuite, on perce à l’aide de la Gomme au 
niveau de l’œil du poisson. Il faut utiliser une gomme précise avec une 
opacité de 100%. On retourne sur le calque objectif et on efface à l’aide 
de la Gomme, les parties qui débordent. Ensuite on va assombrir les 
bordures de l’objectif pour donner de la profondeur. On utilise l’outil Den-
sité +, toujours avec un pinceau à bord doux et une exposition de 20%.

5: LA BOUCHE
À l’aide de la Plume, on trace une forme qui englobe une partie de 
la bouche du poisson. On récupère la sélection en appuyant sur  
[Ctrl]+ clic sur la vignette du tracé. Il faut vérifier qu’on est bien sur 
le calque du poisson et on appuie sur [Suppr]. Ensuite, il faut imagi-
ner le fond de la bouche du poisson. Pour cela il faut tracer, à l’aide 
de la Plume, une forme arrondie qui sera placée en dessous du 
calque poisson. On récupère la sélection et on fait Édition>Remplir. 

On choisit 50% de gris. Ensuite, on utilise encore une fois l’outil Den-
sité + pour assombrir ce bloc. Nommez le calque fond_bouche. Pour 
finir, on importe le fichier 3D1.png. Nommez ce calque 3d_bouche. 
On place le calque entre poisson1 et le fond_bouche. Il faut gommer 
les parties de la forme 3D qui dépassent du poisson. Pour finir cette 
partie, il faut assombrir la partie de la forme 3D qui se trouve à la 
limite de la bouche du poisson (toujours avec l’outil Densité +).  
Ainsi on obtient une ombre qui est totalement contrôlée.
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6: LE MÉCANISME
La première étape consiste à supprimer une partie du poisson. Tracez, avec la Plume, 
une forme qui englobe les épines dorsales du poisson et une partie de son dos. Récupé-
rez la sélection et supprimez-la. Importez le fichier mécanisme.jpg et placez-le au niveau 
du dos du poisson. Nommez le calque mécanisme. Placez ce calque en dessous du 
calque poisson. Il faut détourer, encore avec la Plume, la partie supérieure de l’image. 
Celle qui ne passe pas sous le poisson. Comme pour les autres parties du tutoriel, on 
va créer un ombre grâce à l’outil Densité +. Ensuite, importez le fichier tube_essai.jpg, et 
de la même manière que pour le mécanisme, détourez-le et placez-le au niveau de l’ex-
trémité du mécanisme. Nommez le calque tube_essai et placez-le juste en dessous du 
calque mécanisme. Pour terminer cette étape, importez le fichier 3D2.png et nommez le 
calque 3D2. Placez-le au-dessus du calque poisson. J’ai voulu ajouter encore une forme 
3d au niveau du ventre du poisson. Cette forme est saillante et se marie bien à l’aspect 
squelettique des nageoires. Assombrissez l’extrémité de la forme.

7: LES AMPOULES
Importez le fichier ampoule.jpeg. Nommez le calque 
ampoule. Placez-le au-dessus du calque poisson. 
Détourez l’image pour obtenir une forme ronde. 
Dupliquez le calque deux fois. Placez-les à plusieurs 
endroits et changez leurs tailles. Fusionnez les trois 
calques. Cliquez deux fois sur le calque pour obtenir 
les options du calque. Cochez la case Ombre interne 
et Biseautage et estampage.

6

7
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8: LE CRÂNE
Importez le fichier crane.png. On efface la mâchoire 
inférieure à l’aide la Gomme. Déplacez le crane 
jusqu’aux tentacules du poisson. On s’aperçoit un 
niveau des tentacule, on a une coupure nette. Il faut 
alonger certaine des tentacules. Pour cela, on utilise 
Filtre>Fluidité. On tire dessus grâce à l’outil Doigt. 
Placez le crane de façon à ce qu’un tentacule passe 
par dessus au niveau des trous pour les yeux. Effa-
cez, avec une Gomme à bord doux, la partie de la ten-
tacule qui passe entre les deux yeux de façon à ce 
qu’on ait l’impression que la tentacule passe à l’inté-
rieur du crane. Pour augmenter la crédibilité de l’ef-
fet, il faut assombrir avec l’outil Densité + les trous 
du crane. Pour ne pas se perdre dans les calques, 
créez un groupe et déplacez tous vos calques dedans. 
Nommez le groupe : poisson1.

10: LE DÉSERT
Importez le fichier desert.jpg et placez-le en dessous 
du groupe poisson1. Pour assombrir le désert on va 
créer un masque de Réglages>Niveaux : Gris 100 ; 
0.75 ; 255. Niveau de sortie : 0 ; 255.

9: FOND
Le personnage principal 
est terminé, il ne reste 
plus qu’à trouver une 
atmosphère sombre et 
apocalyptique. 
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11: LES PLANÈTES
Importez le fichier planète.png. Dupliquez le calque deux fois. 
Gommez la bordure avec une Gomme à bord doux, Opacité 20 %. 
Fusionnez les trois calques et nommez-les planètes. Importez le 
fichier : crane.png. Dupliquez-le et de la même manière que pour 
les planètes, gommez les bordures des crânes. De façon à ce qu’ils 
se fondent aux planètes. Fusionnez les deux calques et nommez 
le calque crâne. Importez maintenant le fichier etoiles.jpg. Changez 
le mode de transparence du calque en Superposition. Gommez la 
partie de l’image qui passe sur le sol grâce à l’outil Gomme avec 
une Opacité de 20%. Pour ajouter une lueur à cette étoile, dupliquez 
le calque et faites Filtre>Atténuation>Flou directionnel : Angle 40°,  
Distance 135 px.

12: LES BULLES
Pour les bulles flottantes remplies de sable, je me suis servi d’un 
sablier. Importez le fichier sablier.jpeg et détourez la partie supérieure 
du sablier. Il faut maintenant rendre la bulle vraiment transparente. 
Utilisez l’outil Gomme avec un bord doux et une transparence de 
20%. Gommez légèrement la partie de la bulle qui devrait être 
transparente. Ensuite dupliquez deux fois le calque pour obtenir 
plusieurs bulles et dispersez-les. Fusionnez les calques où sont 
placées les bulles et nommez ce calque bulles.

11
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13: LE DEUXIÈME POISSON
Importez le fichier poisson2.png. Rapetissez-le et 
placez-le à droite du poisson principal. Maintenant 
il faut rendre le nouveau poisson flou pour donner 
de la profondeur à l’image. Pour cela, il faut utiliser 
Filtre>Atténuation>Flou gaussien : 1 px. Il faut assom-
brir ce poisson avec l’outil Densité + pour que la lumière 
ambiante soit en cohésion avec cet élément. Nommez 
le calque poisson2. Vous pouvez ajouter d’autre pois-
sons, la mise en page n’est pas figée, modifiez plu-
sieurs poissons si vous le voulez et éclatez-vous !

15: LA LUMIÈRE
Pour répandre la lumière sur votre création, créez un nouveau calque et 
nommez-le lumière. Placez-le en premier au niveau des calques. Rem-
plissez-le avec du noir et changez la transparence du calque en Den-
sité couleur -. Utilisez maintenant un pinceau avec une opacité de 20% 
ou moins. Choisissez le blanc comme couleur avec une forme de pin-
ceau diffuse et ensuite peignez les zones que vous voulez faire ressor-
tir. J’ai décidé de mettre de la lumière au niveau du tube à essai sur le 
dos du poisson et légèrement sur la forme de la bouche. La lumière est 
très importante en photomontage, c’est elle qui donne le rythme et le 
punch à l’image.

14: LES OMBRES
Pour lier les poissons et les bulles au décor, on doit 
ajouter des ombres. On va commencer par le pois-
son principal. Effectuez un [Ctrl]+ clic sur la vignette du 
groupe poisson pour sélectionner la forme du poisson. 
Créez un nouveau calque et remplissez-le avec du 
noir. Passez la transparence du calque à 70 %. Faites 
un [Ctrl]+[T], puis un clic droit. Sélectionnez Symé-
trie axe vertical. Aplatissez la forme obtenue et pla-
cez-la en dessous du poisson. La forme est trop nette 
pour être crédible. On utilise l’outil Doigt pour rendre 
l’ombre floue et la propager à droite et à gauche. On 
répète l’opération pour le poisson2 en gommant la 
partie qui passe par-dessus la dune. Et enfin on ter-
mine avec les ombres des bulles.
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Nous avons le plaisir de vous 

présenter la rubrique Formations 

dans laquelle les écoles et les centres de 

formations présenterons leurs formations 

en graphisme et multimédia. 

 

Dans cette rubrique vous trouverez 

les présentations générales de ces 

établissements ainsi que les descriptions 

de divers cours qu’ils proposent. Vous 

connaîtrez ses avantages et ses spécificités 

afin de bien choisir la formation qui 

répondra à vos attentes. 

Sur notre site www.psdmag.org/fr  vous 

trouverez la section Formations contenant 

les courtes descriptions des établissements 

et leurs coordonnées.
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en studio
Un éclairage 
beauté

L’idée de cet article est de proposer un éclairage de 

studio qui convient particulièrement bien à la photo 

Mode & Beauté. Nous ferons un survol rapide d’un 

éclairage classique avec deux éclairages frontaux et 

nous regarderons les modifications à apporter.
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Quelques réflexions sur le choix de la lumière en studio et principale-
ment sur l’éclairage beauté d’un mannequin.

Deux principaux types d’éclairages cohabitent : les flashes et la 
lumière continue. J’ai travaillé longtemps avec des éclairages tungs-
tène 1970/1995 et je suis passé vers un ensemble de flashes vers 
1995. L’avantage des flashs, c’est qu’ils permettent de fixer le man-
nequin en mouvement, la lumière est moins pénible pour lui et enfin 
autorisent un travail sans pied pour le photographe. Cependant, 
aujourd’hui, je réalise une partie de mes prises de vues en lumière 
continue, avec des projecteurs halogènes équipés de lentilles de 
Fresnel et de volets. L’ensemble est sur variateurs, ce qui permet 
d’affiner avec précision la lumière et de modeler sa composition. 
Les flashs professionnels sur générateurs asymétriques équipés de 
lampes pilotes suffisamment puissantes (600/650 w) réunissent ces 
avantages.

Gérard Chesneau
Passionné depuis les années 60 par la 
photographie, Gérard Chesneau nous 
propose de découvrir son travail.
Professionnel installé près d’Orléans, c’est 
principalement en studio qu’il réalise ses 
photos de Mode & Beauté.
Après les traditionnels petits et moyens 
formats argentiques, il passe au 
numérique en 2000.

Né en 1948 à Orléans (France), il entre en 1963 dans une école 
spécialisée et sort possession d’un CAP de typographe. Il entre dans la 
presse en 1966, suis des cours à l’Ecole de photographie EFET à Paris 
(France), puis à l’Ecole des Beaux-arts d’Orléans (France).
Création publicitaire dans les presse jusqu’en 2000 puis se lance dans la 
photo de mode en 2001.

Gérard Chesneau
5, rue du Tercier de vigne
45430 Chécy
Contact : photos@eidercreation.com
Sites : http://www.eidercreation.com ou http://www.gerardchesneau.com
Tél. : 06 82 69 83 95
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maîtriser l’ombre portée. En effet, nous disposons en ce cas d’un 
éclairage frontal unique. Le risque est de générer ainsi des ombres 
portées désagréables.

La source trop plongeante pourra faire disparaître les yeux dans 
une ombre mal venue qui assombrira le regard. Selon la morpholo-
gie du visage, cette plongée peut rendre les pommettes saillantes 
et générer des ombres directement en dessous, ce qui ne sera pas 
très joli. C’est également le cas (un peu moins) pour le nez et la lèvre 
inférieure.

Le placement latéral est tout aussi important. Trop décalé sur un 
côté ou sur un autre, l’ombre du nez pourra devenir disgracieuse. 
Et dans un cas comme dans l’autre, l’intérêt de cet éclairage fron-
tal est de rester plutôt face au visage du modèle. Les yeux sont ainsi 
superbes. Un éclairage Type cinéma en somme.

Une distance correcte pour un bol de 70 cm ou 80 cm est d’envi-
ron 70 cm. Deux petites informations qui, quelquefois, surprennent :

1) à chaque fois que l’on divise cette distance par deux, on ne mul-
tiplie pas l’intensité lumineuse par deux, mais par quatre (équivalent 
de deux diaphragmes),

2) plus on approche la source du sujet, plus on adoucira le contour 
des ombres, donc plus d’intensité mais moins de contraste.

UNE RÈGLE CLASSIQUE
Il est courant pour assurer une photo d’utiliser deux éclairages fron-
taux placés à 45°. Un principal (key light) et un second (fill light) 
moins puissant, d’un ou deux diaphragmes, pour déboucher les 
ombres portées générées par le premier.

La construction de cette approche classique est souvent accom-
pagnée d’un troisième éclairage (back light ou rim light) positionné 
à l’arrière du sujet et dirigé vers celui-ci afin d’obtenir un effet de 
contour. Et pour rester dans un schéma type, un quatrième pourra 
être dirigé vers un fond gris pour créer un halo. Ou tout simplement 
sur un fond noir.

Cette disposition de l’éclairage offre une assurance de bons résul-
tats sur les sujets ainsi photographiés. Le portrait est équilibré car la 
lumière est bien répartie et il n’y a pas d’ombres violentes. Cepen-
dant, la contrepartie est que l’on retrouve fréquemment cette com-
position. Il peut être intéressant de réaliser un éclairage différent et 
plus spécifique.

UN ÉCLAIRAGE BEAUTÉ MAIS...
Je vais vous proposer un éclairage légèrement modifié. Cette lumière 
convient très bien pour les photos de mode et de beauté. Le rendu 
favorise le regard par une très belle profondeur et transparence des 
yeux. L’éclairage est assez dur, c’est un choix, mais ce n’est pas un 
problème si l’on prend garde de le diriger convenablement afin de 

Un éclairage beauté en studio
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Un cône (snoot) est quelquefois utilisé, mais je vous proposerais 
plutôt un bol avec des volets, ce qui aura pour effet de composer 
l’éclairage de manière douce avec des formes de géométriques diffé-
rentes. Il peut y avoir deux flashs, à différentes hauteurs pour assurer 
ce travail. Un projecteur de gobos peut également être utilisé, mais 
attention aux images répétitives.

3) Enfin, une troisième source en éclairage d’effet (back light) peut 
être placée à l’arrière du mannequin et dirigée vers celui-ci. Elle doit 
être discrète car on perçoit quelquefois un éclairage d’effet trop vio-
lent sur une des joues du modèle. 

J’utilise fréquemment une boîte à lumière (strip light ou slim light), 
nettement plus longue que large (30 x 120 cm par exemple). Elle 
peut être munie de nids d’abeille (grid) ou de volets pour ne pas para-
siter le fond ou même la lentille frontale de l’objectif.

Voilà un éclairage qui n’utilise que deux voire trois flashs. C’est un 
éclairage parmi des quantités d’autres. Il est simple à mettre en 
œuvre et donne de beaux résultats pour une image beauté.

Modèles : Nanou, Gladys, Cécile, Anaëlle et Awa
Hair et makeup: Tiffany
Texte et photographies: Gérard Chesneau

LA COMPOSITION
1) Prenons le cas d’un portrait. L’éclairage principal n’est constitué 
que par une seule source. Le mannequin est face au photographe. 
La source placée à 70 cm environ du sujet, très près du photographe 
et en légère plongée sur le modèle. Celui-ci dirige son visage vers 
cette source en relevant ou non légèrement la tête pour prendre la 
lumière. Son regard peut être (par exemple) dirigé vers la source ou 
vers le photographe.

Cette première source peut être équipée par un choix large d’ac-
cessoires : parapluie, boîte à lumière, bol, Fresnel etc... Dans le 
cas qui nous intéresse, je vous propose un bol beauté. C’est un bol 
assez large, d’un diamètre de 70 ou 80 cm environ, intérieur blanc 
ou argenté, et muni d’un petit réflecteur au centre pour éviter le point 
chaud.

La maîtrise de tous les paramètres de cette première source est très 
importante car elle sera déterminante sur l’image finale.

2) Une seconde source est très intéressante pour éclairer le fond. 
En effet, celui-ci fait partie intégrante de l’image. Eclairé, il permet de 
détacher certaines parties du sujet tout en créant de la profondeur à 
l’image, ce qui est important. Il doit cependant rester discret.

Un éclairage beauté en studio
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CONSEILS
Le matériel et l’espace
Je travaille avec un boîtier Canon 5D mk2. Un objectif  
Canon 24-105 f:4 L.

Le diaphragme utilisé est f:11 (full-frame) pour une 
profondeur de champ limitée. Le travail sera plus aisé si  
l’on travaille avec des girafes plutôt que des pieds photo. 

Un studio doit être de dimensions confortables (si 
possible) et d’une hauteur satisfaisante (pas moins de  
3,5 à 4 m). Une cabine de maquillage correctement  
équipée contribue au confort de la maquilleuse, du coiffeur  
et du mannequin!

La retouche
N’oublions pas le post-traitement qui peut être effectué par  
le photographe ou un graphiste et qui est déterminant dans 
la retouche d’une image beauté.

Une équipe
Une belle image est un cocktail. Elle est le fruit d’une  
équipe et d’une cohésion sur un travail. Chaque point  
a son importance. Pêle-mêle : le choix du modèle pour  
le projet, la maquilleuse, le coiffeur, la styliste, l’éclairage,  
le photographe…



Réussir
ses photos de nuit

La photographie de nuit offre un terrain de jeu énorme à qui veut s’aventurer 

dans cette voie. La nuit et les lumières urbaines peuvent révéler des lieux 

qui semblent anodins en pleine journée. Ils peuvent alors devenir insolites, 

mystérieux, inquiétants ou même fantasmagoriques... 

La nuit et l’obscurité possèdent une grande portée psychologique sur notre 

imaginaire. Il s’agit donc de profiter de cet inconscient collectif lié à l’obscurité 

pour donner plus de portée à nos photographies.
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La photographie de nuit permet de décupler la force graphique d’une 
construction urbaine, d’une façade d’immeuble, d’un portrait ou 
même d’une simple rue. Grâce aux jeux d’ombres et de lumières, on 
peut très facilement mettre en scène un personnage, fixer le regard 
du spectateur sur ce que l’on désire qu’il regarde et laisser dans 
l’ombre ce qu’on veut lui cacher. Parfois même l’enjeu principal d’une 
photographie de nuit est de cacher, plus que de montrer : l’imaginaire 
du spectateur fera le reste.

Mais la photographie de nuit reste un domaine difficile à maîtri-
ser, aux contraintes très nombreuses et il est nécessaire de l’abor-
der avec patience et humilité, en allant parfois même à l’encontre des 
règles établies pour tirer tout le profit d’une prise de vue nocturne.

Cet article n’a pas la prétention d’être une référence technique. Il 
est plutôt destiné à délivrer mon expérience sur le sujet pour vous 
guider dans vos expériences nocturnes.
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Richard Vantielcke 
Je m’appelle Richard Vantielcke, je vis à Paris et je pratique la 
photographie depuis plus d’une dizaine d’années.

Depuis toujours, Je suis passionné par l’image sous toutes ses formes 
(cinéma, peinture, animation, jeux vidéo), mais c’est avec l’arrivée du 
numérique que mon intérêt pour la photographie s’est définitivement 
révélé, grâce à la possibilité de multiplier les prises de vue et la facilité 
de passage entre l’étape de prise de vue et celle de post-production. 
Aujourd’hui, je travaille plus particulièrement dans le domaine de 
la photographie conceptuelle et narrative, je veux que mes images 
racontent quelque chose au spectateur.

Figure 1. Light Dispenser
Un exemple de lieu anodin 

magnifié par la photographie 
de nuit. L’essentiel du travail de 
retouche a été réalisé sur un vi-
gnettage artificiel pour masquer 
les détails environnants et per-
mettre au regard du spectateur 

de mieux se focialiser sur le 
centre de l’image.
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Pour éviter d’obtenir une image trop plate, on appliquera sur 
les zones voulues un filtre Atténuation>Flou gaussien ou Flou de 
l’objectif.

De même, un temps de pose important va faire apparaître un 
bruit graphique qui va dégrader sensiblement la qualité des images. 
Il faudra alors atténuer au mieux ce rendu en passant par le filtre 
Bruit>Réduction du Bruit

Avec des temps de pose importants, et même en utilisant un tré-
pied, il se peut que vous ayez la mauvaise surprise d’obtenir une pho-
tographie pas complètement nette (la moindre vibration est fatale). 
Voici une astuce pour rattraper le coup. Dupliquer votre photogra-
phie dans un nouveau calque et appliquer le filtre Divers>Passe-haut 
(donner un rayon inférieur à 10). Coller ce nouveau calque en mode 
Incrustation sur la photographie originale et jouer sur l’opacité pour 
affiner ou atténuer l’effet de netteté.

Un autre problème important est celui posé par les écarts de lumi-
nances élevés entre les zones claires (la ou les sources de lumières) 
et les zones sombres.

Une des principales astuces pour éviter cet écueil est de pratiquer 
le bracketting (multiplication d’une même prise de vue en jouant sur 
les réglages de l’exposition), cela permettra d’obtenir pour chaque 
zone l’exposition voulue. Il faut alors ensuite composer son image 
dans photoshop en jouant sur la transparence de plusieurs calques, 
chaque calque proposant une prise de vue avec un réglage différent.

Dans un second temps, la retouche photo va être au service de 
l’histoire que l’on veut raconter, elle aura pour but de magnifier le 
rendu de la prise de vue initiale en accentuant les jeux d’ombres et 
de lumières.

On va par exemple insister sur les zones d’ombres pour cacher 
des détails parasitaires. On peut également choisir d’obscurcir volon-
tairement les bords de l’image afin de créer un effet de vignette, pour 
attirer l’attention sur le centre de l’image, l’obscurité environnante 
va alors définir naturellement le cadre de l’image... À l’inverse on 
va insister sur les zones de lumières via des interventions sur les 
niveaux, la luminosité et le contraste, pour faire ressortir au premier 
plan ce que l’ on veut que le spectateur fixe du regard.

En conclusion, ces quelques règles et astuces devraient vous per-
mettre d’éviter la frustration du débutant, qui commence à s’intéres-
ser à la photographie de nuit et qui peut vite perdre patience devant 
le rendu désastreux de ses premières tentatives. Néanmoins, n’ou-
bliez pas qu’il vous faudra beaucoup pratiquer (perdre du temps à 
répéter les prises de vue vous fera gagner un temps énorme en post-
production) et qu’il ne faut surtout pas hésiter à expérimenter des 
réglages en multipliant les prises de vue ! Équipez-vous également 
d’une bonne veste et d’un pull bien chaud pour affronter l’ennemi le 
plus redoutable de la photo de nuit, le froid !
Bonnes photos !

PARTICULARITÉS ET CONTRAINTES 
DE LA PHOTOGRAPHIE DE NUIT
Le point capital est la gestion de la source de lumière. Avec un peu de 
pratique et contrairement à ce que l’on pourrait penser, il est possible 
d’obtenir des images très intéressantes en utilisant seulement les 
sources de lumière disponibles sur place sans l’emploi d’un flash, qui 
va justement trop atténuer les ombres et nous faire perdre ce rendu 
si particulier de la photo de nuit.

Tous les appareils, qu’ils soient de type reflex ou compact, per-
mettent de réaliser des photographies de nuit. Avec un appareil com-
pact, il faut sélectionner le mode «photo de nuit» qui permet de tra-
vailler à haute sensibilité, sans flash et avec des temps de pose 
pouvant aller jusqu’à plusieurs secondes, cela se fera malheureuse-
ment au détriment de la qualité d’image qui sera dégradée par l’ajout 
d’un bruit numérique (l’image manque de piqué et est parsemée de 
grains colorés).

Avec un appareil reflex, on sélectionnera le mode manuel permet-
tant de jouer à la fois sur le temps de pose et sur l’ouverture du 
diaphragme (plus le diaphragme de l’objectif est ouvert plus il laisse 
passer de lumière). Dans le cas d’un reflex, il conviendra de privilé-
gier un objectif lumineux et une faible sensibilité ISO (100 à 200) afin 
de limiter l’apparition du bruit numérique suite à un temps de pose 
conséquent.

Dans tous les cas, l’utilisation d’un temps de pose prolongé pour 
accentuer la luminosité de la prise de vue impose l’utilisation d’un tré-
pied (dès qu’on dépasse ¼ s de pose), même si cela entraine une 
liberté réduite et moins de spontanéité lors des prises du vues.

Pour éviter les écueils nombreux, il convient alors de se préparer 
méticuleusement avant chaque séance de prise de vue.

Faire un repérage précis sur les lieux du shooting est important 
pour tester ses idées en grandeur nature, en effectuant des photos 
témoins qui permettront d’avoir une idée plus précise des cadres à 
composer et des éclairages disponibles à exploiter.

LE TRAVAIL DE RETOUCHE POUR 
LA PHOTOGRAPHIE DE NUIT
Il est important à ce niveau d’insister sur le fait que la retouche photo 
doit être au service de l’image que l’on désire réaliser. La réussite d’une 
photo de nuit repose en grande majorité sur la prise de vue initiale.

Il est inutile de se lancer dans l’étape de post-production si la prise 
de vue brute ne convainc pas immédiatement. La retouche photo 
est là pour améliorer le rendu initial et accompagner de la meilleure 
façon le message que l’on veut faire passer dans sa composition.

Dans un premier temps, la retouche sur une photographie de nuit 
va se concentrer sur l’atténuation des dégradations de l’image impo-
sées par les contraintes de prise de vue mentionnées plus haut.

Avec une prise de vue en longue exposition (2, 3, 5 voir 10 
secondes), le manque de lumière conduit invariablement au choix 
d’un objectif très lumineux, ce qui va diminuer fortement la profon-
deur de champ.

Réussir ses photos de nuit
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Figure 2. You know exactly where it ends
Perspective de la rue Rataux dans le 5ème arrondissement de Paris. La 
retouche photo s’est ici concentrée sur l’application d’un filtre Atténuation>Flou 
de l’objectif pour obtenir cet effet de profondeur de champs artificiel,absent de la 
prise de vue initiale.

Figure 3. Le voyeur un peu con
Une petite photographie surréaliste. De l’importance de savoir jouer avec les 
éclairages urbains pour sublimer une façade plutôt neutre en plein jour, mais qui en 
pleine nuit révèle de superbes jeux de texture.
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Figure 4. La bâtisse éclairée par la nuit
J’ai volontairement obscurci certaines zones de l’image afin d’isoler complètement cet immeuble, De ce vide, qui cadre l’image, il en ressort une ambiance assez mystéri-
euse et étrange.

Figure 5. Cardboard Box Head : Food box container
Une image qui compose la série narrative Cardboard Box Head. La retouche photo, au service de ce que l’on veut raconter avec une image. J’ai accentué la zone claire, en 
la surexposant volontairement pour faire ressortir cette étrange silhouette de la composition.
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Figure 6. Lighted up
Une façade d’immeuble transformée par la nuit et ce simple lampadaire.
Au niveau de la retouche photo, j’ai accentué l’obscurité ambiante de l’image pour dramatiser la composition et obtenir cette ambiance oppressante.

Figure 7. Light station
Une station à essence perdue dans la campagne, transformée en construction futuriste par la magie des néons.
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chambre   
NoirE

La photographie noir et blanc n’a jamais été aussi souple depuis 

l’arrivée du tout numérique. Autrefois, exilé dans la chambre 

noire réchauffée d’une ampoule rouge, il fallait posséder un 

agrandisseur, composer des gammes et des masques en carton. 

De nos jours, avec du bon matériel, tout se fait en quelques 

secondes, en quelques clics.

Christophe Delarsille
Créatif publicitaire et graphiste, Christophe (35 ans) 
utilise Lightroom depuis peu pour un usage privé 
en photographie. Autodidacte, il en apprécie la 
souplesse. Fan et habitué de Photoshop depuis plus 
de dix ans, il avoue volontiers préférer Lightroom 
pour le développement des fichiers RAW.
Site: http://www.delarsille.be
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1: Choix de l’image RAW
Une image noir & blanc se conçoit de préférence au 
moment de la prise de vue. Une image noir et blanc, par 
l’absence de couleur doit comporter des formes bien mar-
quées, bien contrastées. Préférez un enregistrement en 
couleur même si votre appareil peut proposer un mode 
noir et blanc. Mieux vaut le faire sous Lightroom et en 
maîtriser tous les paramètres. Enfin, sauvegardez vos 
images au format RAW, afin d’être certains de disposer 
de toutes les nuances nécessaires lors du développe-
ment.

2: Correction automatique
Les images tirées d’un appareil digital manquent sou-
vent de contraste. On ressent comme un voile blanc 
par-dessus. Ouvrez l’image _MG_6944.dng. Cliquez sur 
le bouton Tonalité Auto à droite, dans la colonne Dévelop-
pement rapide. Les tonalités sont re-balancées du point 
foncé noir, au plus clair blanc. Sur base de cette image, 
nous allons travailler en mode noir et blanc.
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5: Mélange des  
niveaux de gris
Nous allons naturellement nous pencher sur ce menu qui 
est le plus important de notre exercice. Lightroom permet 
d’interagir sur tous ces tons affichés. Pour ceux d’entre-
vous qui ont connu le travail en argentique, c’est le même 
principe que l’usage de filtres de couleur à la prise de vue. 
Il est bien entendu toujours possible de le faire en numé-
rique. Mais personnellement, je préfère ne pas acheter de 
filtres et faire mes réglages en postproduction.

6: Appliquez vos réglages
Voyez par exemple ce qu’il se passe lorsque nous 
glissons le curseur Orange de la droite vers la gauche. 
Lightroom va rechercher les nuances des feuilles au sol 
pour les affirmer ou les atténuer. Pour cette image, mon 
but est de faire détacher les cheveux du décor, je vais 
donc garder un sol clair et placer le curseur Orange sur 
+57 pour garder des nuances dans les bras des jeunes 
filles. Je fais de même pour le Jaune, avec une valeur 
de +20.

3: Dupliquer l’image
Un des grands avantages de Lightroom réside dans la 
possibilité de créer autant de versions d’image que le 
souhaite votre imagination. Lightroom n’enregistre pas à 
chaque fois une nouvelle image mais attache à l’image 
origine un petit fichier regroupant toutes les modifications 
que vous lui avez apportées. Il est possible de revenir à 
l’original à tout moment. Faites un clic droit sur la vignette 
de l’image et choisissez Créer une copie virtuelle.

4: DEVeloppement
Passons maintenant à l’onglet développement. Sur la 
droite, vous trouverez l’onglet TSI/Couleur/Niveau de 
gris. Choisissez Niveau de gris. L’application propose 
un premier résultat noir et blanc qu’il faudra affiner. La 
souplesse du numérique a aussi son inconvénient : on 
est tenté d’essayer un maximum de réglages et de tous 
les trouver intéressants. Petit conseil : ayez déjà en tête 
la photo finale que vous désirez obtenir. Ca facilite les 
manipulations. Vous irez droit au but.
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7: Comparaison
Créez une seconde copie virtuelle de l’image. Nous al-
lons garder les réglages que nous venons de faire et en 
tester de nouveaux pour rechercher un meilleur résultat. 
Lightroom offre la possibilité de comparer deux images 
sur un seul écran. Cliquez sur l’icône YY (voir ci-dessus) 
pour passer dans le mode avant-après.

8: Virage partiel
Lightroom permet d’ajouter une petite nuance au noir 
et blanc. Sur Photoshop, il faudrait repasser du mode 
Niveaux de gris au mode RVB pour y arriver. Dans 
Lightroom, tout se passe dans le même espace de travail. 
Je rajoute un peu de jaune dans les tons clairs (Teinte 43, 
Saturation 10) et un peu de rouge dans les tons foncés 
(Teinte 11, Saturation 14).
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11: Vignettage  
après recadrage
Une des améliorations par rapport à Photoshop réside 
ici aussi. Si vous recadrez à nouveau votre image, ce 
vignettage se repositionnera autour de votre photo. Sous 
Photoshop, il faut faire un masque sur un calque séparé. 
Une fois l’image recadrée, il faut jeter ce calque et en 
recommencer un autre aux bonnes dimensions.

12: Sauvegardez  
vos réglages
Un autre avantage de Lightroom est la possibilité de gar-
der les paramètres de réglages que vous venez de réali-
ser. Dans la liste des menus de gauche, Cliquez sur le + à 
côté des Paramètres prédéfinis. Lightroom vous propose 
de cocher les réglages que vous désirez conserver pour 
une utilisation future.

9: Détail
L’onglet suivant permet d’ajouter de la netteté à l’image. 
Il faut avancer prudemment avec ces réglages car l’effet 
n’est pas toujours très esthétique. Un petit triangle à 
gauche du menu vous rappelle de passer en affichage 
100% (1 : 1) pour visualiser les effets. Notez que dans la 
prochaine version 3.0, ce module sera revu. La netteté 
sera améliorée et vous pourrez visionner les réglages sur 
toutes les échelles de zoom.

10: Vignettage
Quittons le mode comparaison pour ajouter du Vignet-
tage. Pour cela, cliquez sur le rectangle à gauche de 
l’icône YY pour revenir en plein écran. Le vignettage est 
un effet un peu à la mode en ce moment alors qu’il donnait 
des cheveux gris à tous les photographes argentiques. Le 
vignettage est le résultat d’un défaut de l’objectif, princi-
palement sur les objectifs grand-angle. Maintenant, il est 
assez prisé. Il a pour vertu de refermer l’image et de don-
ner à la photo un côté un peu rétro.
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13: Appliquez vos réglages à  
d’autres photos
A présent, choisissez une autre photo de votre biblio-
thèque et survoler la liste des paramètres prédéfinis. 
Vous verrez que la vignette de navigation se met à jour 
instantanément pour visualiser le résultat. Cliquez sur le 
nom du paramètre pour valider votre choix. La nouvelle 
photo reprend les mêmes réglages en un seul clic.

15: BONUS
Il ne manque qu’une option à Lightroom 2, mais ayant eu 
le privilège de tester le version 3, je peux déjà vous dire 
que le vide est comblé. Il s’agit de l’opportunité d’ajou-
ter du grain à la photo. Mieux gérer que sous Photoshop, 

le grain de Lightroom sera moins mécanique. On pourra 
régler sa taille, son contraste et aussi sa netteté. Dans 
l’exemple ci-dessus, j’ai volontairement accentué l’effet 
pour voir quelque chose une fois imprimé en petit. Vive-
ment la suite !

14: Copier/coller
Une autre possibilité pour appliquer les mêmes réglages 
à plusieurs photos sans sauver ceux-ci est le copier/col-
ler. Si vous voulez récupérer des réglages pour un petit 
nombre de photos en sachant que vous ne les réutiliserez 
plus par la suite, choisissez le bouton Copier..., cochez 
vos choix. Ouvrez une autre image et cliquez sur Coller. 
C’est simple et rapide.
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La champagne nous fait penser à la nuit du réveillon du Nouvel An, de 

feux d’artifices et de vœux. Grâce à ce tutoriel vous allez voir comment 

créer une image illustrant une bouteille de champagne qui pourra être 

ensuite utilisée sur des posters ou des affiches, de sorte qu’elle attire 

l’attention du public et qu’elle ne laisse personne indifférent.

Créer un visuel 

2: DÉBUT
Nous créons une toile A3, 300 dpi avec un arrière-plan 
noir. Nous y plaçons la bouteille de champagne et le 
nœud papillon découpés de sorte que le calque du nœud 
papillon se trouve au-dessus du calque de la bouteille. 
Nous modifions la couleur du noeud papillon de noir en 
rouge à l’aide de l’outil Image>Réglages>Teinte/Satura-
tion (Image>Adjustments>Hue/Saturation), nous sélec-
tionnons l’option Colorer (Colorize) et nous réglons 
ensuite les ascenseurs : 0/80/0.

1: PRÉPARER LES PHOTOS
La première étape qui accélérera notre travail consiste  
à préparer les photos indispensables pour réaliser ce tuto-
riel. Nous ouvrons les fichiers nécessaires et nous décou-
pons le fond blanc de la photo de la bouteille de cham-
pagne et du nœud papillon. N’oubliez pas que la précision 
de découpe des éléments aura une impacte sur les résul-
tats de notre projet.

Karol Góreczny

de bouteille 
de champagne
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4: AJOUTER DE LA LUMIÈRE – 
ÉCLAIRCIR LA BOUTEILLE
Afin d’éclaircir la bouteille, nous créons un nouveau 
calque dans le mode de fusion Incrustation (Overlay) 
au-dessus du calque avec la bouteille de champagne. 
Avec un pinceau doux et la couleur blanche, nous éclair-
cissons la partie en verre de la bouteille. Nous répé-
tons cette étape avec d’autres couleurs de pinceau par 
exemple, bleu, vert, rouge pour augmenter les coloris 
de la bouteille. N’oubliez pas que toutes les couleurs 
doivent se trouver sur des calques séparés.

3: POSER LA BOUTEILLE
Cette étape consiste à créer la base sur laquelle sera posée notre bouteille. Pour ce faire, 
nous créons un nouveau calque en appuyant sur [Maj]+[Ctrl]+[N] en-dessous du calque 
de la bouteille. Avec l’outil Ellipse sélection (Elliptical Marquee Tool) nous créons une 
sélection en-dessous de la bouteille de champagne. Nous remplissons la sélection avec 
la couleur grise au moyen de l’outil Pot de peinture (Paint Bucket Tool). Nous effaçons 
la partie inutile de la base avec la Gomme (Eraser Tool) avec une extrémité douce. Avec 
la sélection activée, nous créons un nouveau calque dans le mode de fusion Incrusta-
tion (Overlay), nous sélectionnons l’outil Ellipse sélection (Elliptical Marquee Tool). Puis, 
nous faisons le clic droit de la souris et nous sélectionnons l’option Contour (Stroke). Nous 
paramétrons l’épaisseur à 1-2 px, couleur blanche.

5: CRÉER DES REFLETS
Afin de créer un reflet de la bouteille dans sa base, il faut copier le calque avec la bouteille 
en appliquant la commande Calque>Dupliquer le calque (Layer>Duplicate layer). Nous pla-
çons le calque dupliqué et nous le tournons via la commande Édition>Transformation >Symé-
trie axe vertical (Edit>Transform>Flip vertical). Nous paramétrons l’opacité du calque à envi-
ron 30-40 %. Nous effaçons ensuite la partie inutile de la bouteille avec l’outil Gomme (Eraser 
Tool) à l’extrémité douce et nous ne laissons que sa base.
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6: OMBRES – AJOUTER UNE PROFONDEUR
Nous passons à l’étape où nous ajouterons les ombres que fait le nœud papillon. Nous 
créons un nouveau calque en-dessous de la bouteille. Avec le pinceau doux noir, nous 
ajoutons une ombre en commençant par le centre du nœud de papillon. Pour créer 
l’ombre dans les parties extrêmes du nœud papillon, il faut utiliser un pinceau très doux 
pour garder le côté naturel des ombres. Nous paramétrons l’opacité du calque à envi-
ron 30-40 %. une fois le calque avec l’ombre sélectionné, nous appliquons la commande 
Calque>Créer un masque d’écrêtage (Layer>Create clipping mask), ce qui permettra de 
placer l’ombre sur la bouteille seulement.

7: BOUTEILLE AVEC DES REFLETS
Avant de passer à l’étape suivante, nous regroupons 
le calque avec les ombres et la bouteille en sélection-
nant les calques tout en maintenant la touche [Ctrl] 
enfoncée. Le raccourci clavier [Ctrl]+[G] sert à regrou-
per les calques ; nous appellerons le groupe crée bou-
teille. Cette étape consiste à ajouter un reflet formé par 
le nœud de papillon. Le calque avec le nœud doit se 
trouver au-dessus du groupe créé. Nous dupliquons le 
calque du nœud de papillon en appliquant la commande 

Calque>Dupliquer le calque (Layer>Duplicate layer). Nous 
plaçons le calque dupliqué tout en haut des calques, dans 
le groupe bouteille. Nous déformons le nœude papillon 
avec la commande Édition>Transformation>Déformation 
(Edit>Transform>Warp). Ensuite, nous l’étalons en tirant 
sur les extrémités du nœud. Nous paramétrons le mode de 
fusion à Incrustation (overlay), l’opacité du calque à envi-
ron 15-20 %. Nous cadrons le reflet avec la commande 
Calque>Créer un masque d’écrêtage (Layer>Create clip-
ping mask).
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9: Effet – eau
Nous ajouterons à cette étape un effet d’eau autour de la 
bouteille de champagne. Nous ouvrons les fichiers indispen-
sables et nous y découpons les éléments nécessaires avec 
l’outil Lasso Polygonal (Polygonal Lasso Tool). Nous allons 
à situer l’eau autour de la bouteille. Il n’appartient qu’à vous 
de placer les éclaboussures d’eau mais n’oublions pas de 
garder leur forme spirale. Nous plaçons les fragments tout 
en haut des calques et nous paramétrons leur mode de 
fusion à Densité linéaire- (Linear Dodge), ce qui permet-
tra de faire disparaître l’arrière-plan noir. Après avoir sélec-
tionné le calque avec la partie principale de l’eau, nous appli-
quons la commande Édition>Transformation>Déformation 
(Edit>Transform>Warp) et nous essayerons de plier la par-
tie inférieure de l’eau derrière la bouteille. Nous masquons 
la partie supérieure tout en gardant la sélection du noeud 
papillon activée.

 8: BOUTEILLE AVEC DES REFLETS
Avant de passer à l’étape suivante, nous regroupons le calque avec les ombres et 
la bouteille en sélectionnant les calques tout en maintenant la touche [Ctrl] enfon-
cée. Le raccourci clavier [Ctrl]+[G] sert à regrouper les calques ; nous appellerons le 
groupe crée bouteille. Cette étape consiste à ajouter un reflet formé par le nœud de 
papillon. Le calque avec le nœud doit se trouver au-dessus du groupe créé. Nous dupli-
quons le calque du nœud de papillon en appliquant la commande Calque>Dupliquer 
le calque (Layer>Duplicate layer). Nous plaçons le calque dupliqué tout en haut des 
calques, dans le groupe bouteille. Nous déformons le nœude papillon avec la commande  
Édition>Transformation>Déformation (Edit>Transform>Warp). Ensuite, nous l’étalons 
en tirant sur les extrémités du nœud. Nous paramétrons le mode de fusion à Incrustation 
(overlay), l’opacité du calque à environ 15-20 %. Nous cadrons le reflet avec la commande 
Calque>Créer un masque d’écrêtage (Layer>Create clipping mask).

10: PLUS D’EAU
Nous ajoutons d’autres éléments d’eau en dupliquant le 
calque modifié ci-dessus. Nous retournons le calque via 
la commande Édition>Transformation >Symétrie axe 
vertical (Edit>Transform>Flip vertical). Nous créons un 
masque de fusion et nous allons masquer l’eau qui doit 

se trouver derrière la bouteille. Nous ajoutons de l’eau 
suivant notre intuition, en dupliquant et en modifiant les 
éléments ajoutés auparavant. Nous utilisons principale-
ment la commande Édition>Transformation>Déformation 
(Edit>Transform>Warp).
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11: ENCORE PLUS D’EAU
Nous avons besoin de petites éclaboussures d’eau. Nous ouvrons la photo avec une 
vague d’eau et nous lançons les ascenseurs Niveaux (Levels) – [Ctrl]+[L] nous les 
paramétrons selon l’image jointe, ce qui permettra d’assombrir les ombres et d’éclai-
rer les lumières. Une fois les paramètres acceptés, nous choisissons la commande 
Sélection>Plage de couleurs (Select>Color Range). Nous paramétrons l’ascenseur à 
environ 46 et nous cliquons avec la Pipette sur la partie claire de l’eau. Nous validons la 
sélection. Nous copions le fragment d’eau en appuyant sur [Ctrl]+[C] et nous passons au 
projet principal. Nous nous plaçons sur le calque en-dessous du groupe Bouteille et nous 
y collons l’eau en appuyant sur [Ctrl]+[V]. Nous modifions le nom du calque en eau et son 
mode de fusion à Éclaircir (Lighten).

12: TOUJOURS DE L’EAU
Nous procédons pour masquer l’eau. Nous créons 
un masque sur le calque eau via la commande 
Calque>Ajouter un masque de fusion>Tout faire appa-
raître (Layer>Add layer mask>Reveal all). Ensuite, nous 
masquons l’eau au moyen d’un pinceau noir très peu 
épais dans les endroits où nous n’en avons pas besoin. 
Nous dupliquons le calque et nous procédons de la 

manière décrite ci-dessus. Nous regroupons tous les 
calques en un seul groupe appelé eau. Nous ajoutons 
les autres calques d’eau au-dessus du calque contenant 
le noeud papillon. Nous plaçons l’eau au coin inférieur 
droit du nœud papillon, ce qui donnera une impression 
d’éclaboussures d’eau.
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13: REFLETS SUR LA BOUTEILLE  
ET L’EAU
Cette étape consiste à ajouter d’autres lumières sur 
la bouteille et sur l’eau créée. Nous créons un nou-
veau calque tout en haut des calques. Nous paramé-
trons le mode de fusion du calque à Incrustation (Over-
lay) et son opacité à environ 30 %. Nous choisissons un 

pinceau doux et épais de couleur blanche et nous ajou-
tons de la lumière au milieu de la bouteille. Nous créons 
un nouveau calque et nous ajoutons de la lumière sur 
la surface de l’eau. Nous choisissons un pinceau doux 
d’une petite épaisseur et nous ajoutons des reflets lumi-
neux de manière similaire à la capture d’écran présenté.

14: PEAUFINAGE DE L’EAU
Regardons l’eau que nous avons créée et corrigeons 
les endroits qui en ont besoin. Il est possible d’omettre 
cette étape si vous êtes satisfaits du résultat obtenu. 
Pour notre part, nous avons remarqué deux endroits 
à corriger : l’eau dépassant la bouteille et la fusion 

de l’eau au centre de la bouteille. Nous corrigeons 
ces éléments en copiant les fragments de l’eau et 
en ajoutant le masque Calque>Ajouter un masque 
de fusion>Tout faire apparaître (Layer>Add layer 
mask>Reveal all).
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15: NETTETÉ
Nous enregistrons le travail prêt sous JPG, en l’appelant 
par exemple : Champagne. Nous ouvrons le fichier créé et 
nous dupliquons le calque Background. Nous appliquons la 
commande Filtre>Divers>Passe-haut (Filter>Other>High 
Pass). Nous paramétrons l’ascenseur à environ 4,5, nous 

acceptons ensuite les paramètres. Nous réglons le mode 
de fusion du calque à la Lumière tamisée (Soft Light). 
Nous sélectionnons le calque Background, nous appli-
quons la commande Filtre>Renforcement>Accentuation 
(Filter>Sharpen>Sharpen). Et voilà! Nous pouvons enre-
gistrer notre champagne!

16: ASTUCE
En créant l’eau, essayez de modifier les calques dupliqués de sorte qu’ils ne se res-
semblent pas. Essayez d’inventer en testant divers éléments découpés. Ceci vous per-
mettra de choisir la meilleure position de l’élément d’eau.
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http://www.creabar.com
http://www.creabar.com
http://www.pnxdesign.com
http://www.pnxdesign.com
http://forumde.lalogotheque.com
http://forumde.lalogotheque.com
http://www.photoshop-creation.com

